
e2studio 1.1.0.30 Release Note: 17th October 2012

New features in 1.1:

Description
Debug configuration options improved for RX and RL78.  For example RX now supports external RAM 
configuration and flash overwrite options.

Build and debug support now available for the SH device.  GNU SH and Renesas SH C toolchains 
are supported. E10A-USB debugger is supported.  Device families are SH2 and SH2A.

SH supports the trace and evenpoints functionality in the same manner as RX and RL78.
Profile plugin developed.  Any device that has trace functionality is supported.
Coverage plugin developed to support RL78 IECUBE.
Enhanced memory plugin developed to provide endian aware rendering modes and improved memory 
fill capaiblity.

Importing memory via a file also has improved performance.

Register radix can now be defined on a per register basis.  It is saved to the debug configuration.
Project wizard improved for easier device selection and nicer look and feel.
New import facility to import projects from the HEW IDE to e2studio.  Supports HEW 4.07 onwards 
and SH and RX projects.

Important workarounds useful to know when using 1.1.0.30:

ID Component Description

2037 Application

Symptoms: E2Studio is unable to connect to a debugger 

Conditions: Occurs on the second instance of invoking the debugger (GDB server) after a failed first 
attempt at connection. If a connection issue occurs in the first instance, then a second attempt is 
made after trying to correct the hardware issue, a second instance of the process xxx-elf-gdb.exe may 
start, blocking any further connection attempt.

Workaround: Disconnect the debugger to release the USB driver. Then use CTRL+ALT+DEL to 
access the Windows Task Manager and find any xxx-elf-gdb.exe processes still running and 
terminate them. Ensure the hardware power and connection settings are correct, and that the correct 
MCU and debugger are configured in E2Studio and attempt to reconnect.

901 Application

Symptoms: A renamed project may fail to build

Conditions: Renaming a project can cause a previously valid project to fail the build process. The 
library becomes incorrectly named..

Workaround: The "Build Artifact" under C/C++ Build->Settings can be manually renamed

2005 RXC RX Build Plugin

Symptoms: “-rom” option (part of “Linker > User defined options”) cannot be deleted and may cause a 
linker error if memory sections are changed

Conditions: If a –rom linker option exists in the Linker > User defined options, that does not match the 
sections, the linker will fail. Sections can be changed and the –rom option can be changed, but the 
–rom option will re-appear after the delete feature is invoked.

Workaround: Change the –rom option or sections to match each other even if it means creating empty 
sections.

2010 HEW Importer

Symptoms: Project fails to build after import from HEW

Conditions: If a long filename or path is used, and the HEW project importer is used, the project may 
fail to build.

Workaround: Move the original HEW project to a shallow directory structure (i.e.) C:\Workspace and 
import from there.

1922 Application

Symptoms: Project fails to build in first instance after archive project import (not from HEW)

Conditions: If an archived project is imported it may fail to build the first time, due to a residual .d file.

Workaround: Clean and Build a second time.

1730 Application

Symptoms: Macro expansion fails due to invalid Placeholder.

Conditions: Placeholder (being used in include path) corrupted if the source folder is deleted.
${workspace_loc:/${ProjName}/src}
becomes:
"${workspace_loc:/PlaceCorrupt/PlaceCorrupt/src}"

Workaround: If you intend to delete the source directory, the include paths need to be updated or 
removed from include path list prior to deleting the source directory.
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Fixed issues in 1.1.0.30

ID Component Description

1961 Application

Obsolete hardware debug plugins are not disabled which causes an exception when upgrading for 
1.0.0.38 to 1.1.0.29.  To remedy the problem in 1.1.0.29 do the following:  
 1. Close e2studio.
 2. Browse to the folder C:\Renesas\e2studio\eclipse\plugins.
 3. Delete the plugin named com.renesas.hardwaredebug.e1v850_1.0.1.201207131525.jar.
 4. Re-start e2studio and view your debug configurations.

Fixed issues in 1.1.0.29

ID Component Description

1861 Application Cannot connect to a RL78 G13 101GC with IECube.  This affects more devices than just the 101GC.

1971 Application
When using coverage, lines not being marked covered when suspending via the suspend button on 
the Renesas Debug tool bar.

792 RX build plugin

 Custom added build configuration results in project build failure.
 

The error occurs as the linker section feature is not available for the newly added build configuration. 

915 Application

 When adding a new .src file to the project and build is initiated the source file is not built.
 

1856 Project Generation

Error when building project.  After creating a new GNU project with default settings, it will sometimes 
 fail to build (error from GNU RX project):

 **** Build of configuration HardwareDebug for project TestRx2 ****
 

 make all 
 'Invoking: Library Generator'

 rx-elf-libgen  -o "libTestRx2.a"
 'rx-elf-libgen' is not recognized as an internal or external command,

 operable program or batch file.
make: *** [libTestRx2.a] Error 1

568 Real-time Memory No context sensitive help exists in the real-time views.
468 Real-time Watch Realtime Chart View only working for first hardware debug session

1901 Application

If you delete support files like the gdb or IO files for devices you can recover them by following these 
 steps:

 Go to the internal directory under the e2studio folder.
Edit the version_info.txt file and change the version number to be one less than the number currently 

 in the file.
 Save the file and restart e2studio.

e2studio will now begin copying the support files in the DebugComp, internal & utilities directories.

569 Real-time Memory

It is possible that after debug runs the real-time chart may stop working.  Even if the real-time watch 
 view is updating the chart does not.

 

e2studio will require a restart to fix this problem.

870 Application

GNU RX Build component, building of Assembler file fails if workspace is located in the path with 
 spaces.

 

1124 Real-time Watch
On adding an expression to the expressions view for the first time you may get a null pointer 
exception. On pressing "Add new expression" again you will be able to add an expression.

1176 Real-time Watch
Sometimes on suspend the expressions being monitored will disappear temporarily until the next time 
the debugger is resumed

1823 Real-time Watch

Expressoins view will display an error message for global variables/expressions saying target not 
 available while running.

 

This is confusing as it simply means that this variable is not being monitored in real-time.  This 
message has been improved.

1150 Real-time Watch
When using the RL78 family (with limited realtime monitoring) there is no notification to the user that 
all available memory has been used in the Expressions View

1458 Project Generation Imported projects contained toolchain directories of the original owner.

1789 Application

 When using re-start with RL78 the temporary breakpoint set as main is not cleared correctly.
 

This is only noticed when there is a loop right at the beginning of main.  The address the breakpoint is 
 set at for main is the start of the loop.

 

 The program appears to execute but stops after 5 or 6 iterations of the loop.
 

To workaround this issue remove the breakpoint at main from the debugger start settings or add a line 
of code before the while loop - such as a nop.

530 Debug Configuration

"In the debug configurations, when clicking the 'Debugger' tab (e.g. from the 'Startup' tab), in my 
system it takes 4-5 seconds until the tab comes up during which the window is in an 'in-between' 
state."

1925 Application

 If you can not change the number format of all the registes, please do the following:
 1) Select all registers except the "General Registers" label.

 2) Using context menu select "Register Format" and select "Default"
 3) Un-select the registers.

4) From Number Format menu you will now be able to change the format of all registers.

370 Application
Following a product update the product version on the about box installation history does not get 
updated.

1107 Application
If you remove all the sections under Project->Properties->C/C++ Build->Settings->Sections, then 
apply the settings, close the properties dialog then re-open the sections section, causes an exception.



91 Application

If skip all breakpoints is clicked with the target running & multiple breakpoints are set, GDB returns 
 the following error and the debug session is terminated.

 

 961,041 ~"Interrupted while waiting for the program.\n"
 961,041 ~"Give up (and stop debugging it)? (y or n) [answered Y; input not from terminal]\n"

 961,042 =thread-group-exited,id="42000"
 961,042 29^error,msg="unknown error"

 961,042 (gdb) 
 

When running in non-stop mode this no longer happens for any of the devices. (RX, RL78, SH)

1511 Application

If a variable value is changed within the Variable or Expressions window it does not update inside the 
 memory view. (Although it does if you perform a step).  

1276 Application

When creating a new project the src folder is the only one considered valid for build source by 
 default.

 

Currently the project folder is not a valid location for source files.  Files added here are not 
 automatically built.

 

127 Application The default for the registers window should be hex not decimal.

1315 Application

Following an import into 1.1 the RX_Converter.exe tool needs to be removed from the post build 
 steps.

This tool is now included in the user interface.

558 Application
The CPU reset in the Renesas debug view does not highlight the PC in the editor.  A message is now 
displayed to tell the user about this so there should be less confusion.

880 RX build plugin

 The default iodefine.h file for an RX62N is incorrect when using little endian data.
 

With an example project using the ADC, Accelerometer, Temp Sensor & LCD on the RX62N RDK. 
When compiled for Big Endian all function correctly. Switching to little endian causes the LCD to stop 
functioning. 

1478 Trace plugin Saved SH Trace cannot be loaded back into the view.

1874 Application

 Deleting directory can cause e2studio to lock up.
 Withing e2studio, delete the "src" directory.

From file system, copy another directory with source code to your project and rename to "src" (case 
 sensitive).

 Refresh within e2studio.
All new source files are "excluded", and cannot be "included" ("exclude from build management 
mechanism does not work).

609 Application

Some options are not updated for all the configurations after updating the options on selecting All 
 Configurations

Latest development environment.
1481 RX build plugin User can not remove the last section in Sections viewer list-box.  RX C build plugin.

854 Real-time Chart All realtime views will accept an inverval of no less than 100 milliseconds.

1855 Application

Sometimes when attempting to delete a project, with remove from disk checked, the operations fails 
 due to an open file.

 

 The error message displayed is:
 

 Problems encountered while deleting resources.
   Could not delete '/TestRx1'.

     Problems encountered while deleting files.
      Could not delete: C:\e2studio_images\1_1\22\jubula_test_workspace\TestRx1\.info.

737 Application
When restart is used the target does not stop at the breakpoint set in the Start-up tab in debug 
configurations.

793 Real-time Watch

Realtime Views sometimes stop updating after 5 minutes. When this happens all the views stop 
 updating simultaneously. Manually refreshing does not fix the issue.

 

Terminating and re-connecting to the target should solve the problem.
1286 Debug Configuration The Launch Configuration created during Project Generation should be created in the Project.
1202 Real-time Watch Adding an Icon to identify which expressions are monitored in real time would help the user.

1262 Debug Configuration

 Change default GDB & Io File paths to be relative to eclipse home.
 

 GDB location should be specified by ${eclipse_home} placeholder.
 

Now the debugger configurations are shared and therefore exported with the project the GDB location 
needs to be eclipse directory location independent.

1406 Profile plugin
Profile View is not displaying results profile results for IECube since labels are not being set for the 
trace records.

322 GDB Initial debug view is at incorrect address.  Caused by an erroneous PC register value.

298 Application

While the target is running the "restart" button is active. If the "restart" button is pressed while running 
and a software breakpoint is hit the debugger provides no indication that the target has stopped. If the 
"pause" button is pressed at this point, the PC is shown at the breakpoint location.

1203 RX build plugin

 When building with the Renesas CCRX toolchain with many files the link can fail.
 

 This is because the constructed command line is too long.
 

To avoid this - use the external sub-command file option.

1811 Real-time Memory
Real-time memory update does not work for RDK RX63N.  The function works correctly in the 
expressions view but not the memory view.

1006 GDB server

 When debugging with RL78, a reload operation can cause GDB to GPF.
 

 This is easily reproduced when using real-time updating in the expressions and chart views.
 

It can also happen with other devices such as RX but is less easy to reproduce.

1436 GDB server EXEC

Creating an OA eventpoint with RL78, setting the data compare to more than 1 bytes of data causes 
 the eventpoint not to set.

e.g A compare with fc works but 3fc fails
783 RX build plugin  -nofpu option for RX200 is not passed when switched from RX600 to RX200.



1767 Application

 There are problems debugging RX big endian debuggers.
 

Error message is shown at connection stating it cannot find a file with the extension .mon.

1875 Application
Hex endian is the default memory rendering and is not endian aware.  We will default instead to Hex 
Integer which is a new memory renderer provided in e2studio.

1723 RX build plugin
'Reneasas compiler inbuilt macros /defines' are not currently used in the dependency scanning 
process when using the Renesas compiler.

1570 Debug Configuration The default value for the RL78's verify on writing to memory should be 'yes' but is actually 'no'

698 Debug Configuration
In the debug configuration for RX E1 the debug configuration dialog is not remembering the voltage 
choice of 5V.

1449 Application

 Default C++ project for RX630E with E1 emulator does not build.
 

Also affects RX210 projects. A workaround is to delete the .option_bytes & .endian_bytes sections.

939 RX build plugin

 Linker section editor user interface needs improvement for CCRX.
 Unable to add section without selecting existing section & UI does not indicate this.

As a result unable to add section before start of current sections without convoluted process 
 rearranging sections after creating new section

This also seems to be an issue with the GNU section editor.

882 Application

 Eventpoints are project based in e2studio rather than workspace based.
 

A side-effect of this limitation is that eventpoints can only be set in project source code.

842 RX build plugin

 Summary of issues with RXC Section editor:
 

 Cannot set section to address of 0, this sets to follow on from previous.
 Clearing address should set to follow on from previous

 Unable to add section without selecting existing section & UI does not indicate this.
As a result unable to add section before start of current sections without convoluted process 

 rearranging sections after creating new section.
 This also seems to be an issue with the GNU section editor.

 

When opening or importing any RXC project created prior to version 1.0.0.38 the sections will need to 
be corrected before building.

1468 Application

 e2studio/GDB not preventing loading to invalid memory.
 

Loading code to address 0xFFE00000 on RX62N generates no errors or warnings. In HEW, this was 
 caught on download.

Mechanism should allow loading code to Internal RAM/Flash or external memory(if expanded mode).

1081 GDB server
 Trace is taking up to one minute to return in IECube and sometimes timing out

This is only noticable on the IECube target where the trace buffer is full with 65536 records

1236 GDB server

Reset->Reload->Run functionality can cause target stability problems.  This is due to the 
 asynchronous nature of these features - operating them in close succession can cause a GDB error.

 

1469 Application

Using debug configuration startup "set breakpoint at:" only works once after starting a debug 
 session.

Subsequent reset/go sequences no longer stop.

1549 Event points plugin
The dialog allows for adding a 3rd OA eventpoint to the sequence (which the hardware does not 
support)

1498 Debug Configuration

 GDB location should be specified by ${eclipse_home} placeholder.
 

Now the debugger configurations are shared and therefore exported with the project the GDB location 
needs to be eclipse directory location independent.

1239 Application

 e2Studio tries to integrate the Toolchain even after the toolchain is un-installed from the machine.
 

This can cause problems on e2studio start-up.

1479 Debug Configuration

 External Memory Area bus width needs to allow 32 bit.
 

On some RX devices (RX621, RX62N, RX630, RX631 and RX63N) external memory areas should 
have 32 bit as a selectable bus width.

112 Application
When using the RX C compiler, value assignments to ports (declared in the header files) are shown 
as syntax errors in the editor view.

1285 Debug Configuration

 RX Debug Options need to allow setup of external memory areas.
 

When 'Register Setting' is set to 'On-Chip ROM Ext. ON' HEW allows the specification of External 
Memory Areas.

1254 Real-time Memory Dialog to indicate maximum memory reached for RL78 real-time memory appearing twice.

826 Application
e2studio seems to lock-up on repeated clicks of the restart toolbar button. Condition being that said 
button is clicked as soon as enabled during a restart.

490 Application e2studio current GDB versions do not support the python scripting switches.

1351 Application

 Installer does not install VS2008 redist under Windows 8.
 

 Following installation on Windows 8.
 When launching the debugger it fails with a side-by-side error.

 

 If you then install:
 http://www.microsoft.com/en-us/download/confirmation.aspx?id=5582

 

 It fixed the issue and connection was successful.

1330 Application

 The .linker files are only updated/refreshed from the build settings after a build.
 

If you change the linker settings and then do not perform a build and then export an error occurs.  It 
states a resource is out of step with the file system.

181 Application

Status of memory window not properly maintained through debug connection.  When the debugger 
connection is terminated and re-established a new memory monitor is required to get updates again.  
This is an Eclipse bug in the standard memory view.



308 Application
When using the Renesas RX C toolchain in e2studio, updating a header file will not force the 
managed build system to rebuild files which include that header. 

1261 RX build plugin

When using RX C build pluin and adding the following command to the user options of the compiler 
 the build fails.

 

 -define=LED1=P5_5
 

This is valid syntax for the defines command.

608 RX build plugin

Message is displayed every time 'Restore default' is pressed.  Go to Library generator -> Settings.  
 Select Restore defaults.  

 

Following message is displayed: "Please note that reserving registers for use by the fast interrupt is 
 incompatible with pre-built system libraries".

 

690 Application

The JTAG frequency in Eclipse is not used for Segger connected devices. Interface to the Segger 
 device is currently done through the J-link application.

This applies to any other settings defined by the J-Link application to setup the Segger chip.

1008 Application

 In the linker user options, there is:
 -rom=D=R,D_1=R_1,D_2=R_2

 

 This option needs to modified (to add sections).
Modifying this line appears to work, but once changes are applied the new line is in place, but also a 
second line with the original contents are still in place.

184 Application
The general registers view should be able to show registers as floating point values.  In addition need 
to show PSW/FPSO as enumerated bits, etc.

617 Debug Configuration
V850: Options in Debugger configuration > debugger tab are not saved when user clicks apply button 
of Debugger configuration.

971 Application Source file icon decoration for per-file build settings is missing from the project explorer view.

1122 Real-time Watch
With realtime enabled, the program suspended, and modified source code (causing a reloaded 
project) then resuming the program can cause the GDB server to crash.

180 Application

 Hex display rendering of memory does not correctly handle endian.
 

Suggest to use the traditional rendering or use the memory browser.

1190 GDB server
Running e2studio from a path with a space will cause a crash in the GDB server during debug 
connection

238 Application

Dependency to be handled in case CPU is changed from RX200 to RX600 under compiler CPU, then 
 library generator and assembler should also be updated with the latest CPU option. 

 This does not work as expected currently. 
 

CPU option is not correctly passed to assembler and library generator during project build.

987 Application
Exporting project if linker sections are modified and not saved generates an error.  Resource not 
synchronized is the message.

1037 Project Generation GNURL78: .rodata section should be within Flash Mirror Area.
672 Application RXC Errors not being parsed into Problems View.

996 Application

"No toolchain installed" dialog message from e2studio on start-up when no GCC toolchains 
 installed.

 

This occurs even when a valid CCRX Renesas toolchain is present.

787 Application
Changing the path for the Linker Archive and then clicking Apply and OK does not result in the path 
being changed when visiting the dialog again.

183 Application Memory window does not support floating point rendering option.
982 Application Section names are limited to 20 characters for RX C when this limitation was not in HEW.
928 Application Build fails when user add multiple commands in post-build.

384 Project Generation

Currently the project generator wizard pages in KE/E2S are designed using the fixed size, i.e, the 
layout size and the components are organized according to the standard resolution for Windows 7 

 OS.
 

However, if opening the e2studio IDE on the another platform (e.g., Linux or Windows OS with 
different resolution), the resolution of the native OS may not support the current resolution. 

911 RX build plugin '-undef' option is not passed to libgen for any GNU projects.

927 Application

 Go to Assembler -> Object. mpid option is available for selection
 

This option should not be present as the compiler > CPU > 'Generate position independent code and 
date' option should take care of passing to assembler as well.

910 Application
For GNU projects.  The "Store string consts in the writable data segment (-fwritable-strings) option is 
not displayed in e2studio user interface.

918 Application Build file -lang option is passed incorrectly when compared to standard project build.
941 Application RL78 G13 project build fails for cpu type R5F1018A.

897 RX build plugin
The name of sections in the linker section editor is limited to 20 characters. This needs to be 
extended to match the compiler limitations.

766 Project Generation

 Project generated for RXC 1.01 toolchain has a bad vector_table.c which has a syntax error.
 

For workaround, generate a 1.02.00 project and swap the toolchain to 1.01.00.
845 Application Linker section editor allows to add spaces in the Section name field.

717 Application
 Changes made to build settings between clicking Apply and OK are not saved to the settings.

When visiting the dialog the settings are not present.
559 Application Reload image should have a checkbox remembering your choice.

688 Real-time Watch

 Real time expression not working without re-connect.
 

The first time the project is opened and debugged it not possible to view anything in the real time 
expressions window. The debugger must be disconnected and reconnected to start the updates. New 
additions etc then work OK.

545 Project Generation Build steps dialog does not allow multiple pre-build steps.
708 Trace plugin Trace address filter end range value gets converted to decimal from hex display.

179 RX build plugin
Changing toolchain version (via C/C++ Build -> Change Toolchain Version) does not change the 
include paths set in the compiler options.

847 RX build plugin Linker section options are enabled when user opts to use external linker script.
726 Application RX630 could not be connected using JTAG switch.



Fixed issues in 1.0.1.18

ID Component Description
1424 GDB Server Connection for RX630E with JTAG connection was failing.
1307 GDB Server Connection for RX630E with Segger emulator was failing.

1281 Build plugin

Linker archive paths were accepting Eclipse placeholders and then changing back to absolute paths.

Fix now allows placeholders correctly and an additional placeholder ${TCINSTALL} has been added.  
Projects will default to this when created.
Note: Changes also made to the compiler include paths but these do not default to the new 
placeholder when a  new project is created.  This will be rectified in a later release.

1361 IO view plugin Latest IO files for RX added.

1365 Application

RL78 device support updated. 
1) RL78/G13:
 Device file DR5F101AG.DVF udated:
- correction of internal Flash memory size: 128KB (previous 96KB)
- correction of internal Flash memory size: 12KB (previous 8KB)

2) RL78/G14
Device file DR5F104BD.DVF updated:
- correction of internal Flash memory size: 48KB (previous 32KB)
- correction of internal Flash memory size: 5.5KB (previous 4KB)

3) RL78/L12
All device files updated to V1.01:
The interrupt request name of the vector table address (0044H) 
has been changed to INTLCD (previous name: INTLCD0)

1371 Project Generator RX62N IO define file updated for the Renesas RX compiler.

Fixed issues in 1.0.1.14

ID Component Description
166 RL78 build plugin Build file for RX C rebuilds file every time rather than only building when changes are needed.
279 Application GDB server and port number although configurable are currently hard coded.

576 Real-time Watch
Structure dereferencing not available in the real time expression window.

791 Application
Importing projects does not allow an easy way to move the toolchain path if the toolchain is either in a 
different location or does not exist.

876 Application
Unable to set OA Address range for RX targets. Workaround: set another eventpoint first to channel 
0.

902 Application After adding a new build configuration the new configuration cannot be built successfully.
490 Application e2studio current GDB versions do not support the python scripting switches.

1054 Application
Only two RL78/D1A devices are currently supported.  R5F10DPG , R5F10DPJ.  More devices are 
required to be added.

1249 Application Realtime does not work with old RL78 launch configurations
1245 GDB Server EXEC RL78 realtime only allows monitoring of 8 bytes.

Open issues in 1.01.00.30

ID Component Description

16 Application
When debugging Segger J-Link application using RX, at the first (invalid) breakpoint, it shows 
garbage values for global variables.

17 IO view plugin

There are some IO Registers where the same memory address holds 2 registers with difference 
access sizes. These registers are general a read-only register and another register used for writing 

 which is write-only.
 

These registers are currently all listed as R/W in the IO Map file and so the view will attempt to 
display values for the wrote-only registers. When it does this the bytes are displayed reversed.

40 Application
The message "Error: Unable to create variable object" is sometimes shown during debugging when 
stepping out of functions.

41 Application

Register values have incorrect initial values when using the RX Simulator or RX hardware debugging.  
Initially, R0 values are same as ISP in E2S whereas R0 values are same as USP in the HEW 

 environment. R0 is alias to USP.
 Later on the R0 values are same as ISP / USP depending on the stack usage.

 

Incorrect Accumulator value is displayed (i.e, Accumulator is 0, when checked on command line as 
well, gdb does not update accumulator values).  This is a RX Simulator issue.

72 IO view plugin
All IO registers for RX devices are listed as Read/Write? in the IO xml files used by the IO view, even 
though some are read or write only. 

110 Application

e2studio needs permissions to write to the installation directory.  This is a standard Eclipse problem 
however you may experience issues registering your toolchains or performing updates if you do not 
have administration access when using directories with restricted access.

220 GDB server

e2-server-gdb executable currently causes a security alert in Windows when executed for the first 
time.  The publisher is currently undefined also.  Accepting the dialog allows normal operation to 
proceed.

268 Application

When debugging in e2studio only the file name is used to match breakpoints when debugging. So a 
breakpoints set in a different project to the one being debugged can cause breakpoints to be set on 

 the debugger, if the file name matches.
 

There is no indication in the breakpoints view which project a breakpoint is in, but the marker will only 
appear in the correct file.

301 Trace plugin Trace buffer full functionality needs addition.  New checkbox needs adding to the GUI.



364 Application

 

 

In case of MinGW toolchain projects - Whenever you add any include path in the compiler / 
 assembler include path option, it is displayed in the Project Explorer -> <prj_name> -> Includes.

In case of KPIT / Renesas toolchain projects - Whenever you add any include path in compiler / 
 assembler include path option, it is not displayed in the Project Explorer -> <prj_name> -> Includes. 

 

It only displays the default include paths added during project generation.  The include paths are 
shown in the build option preferences as you would expect.

373 GDB server
e2studio does not support debugging using multiple E1 emulators connected to the system.  There is 
no way to select which emulator you would like to connect to.

392 GDB server FFW

When using a brand new RX62N RDK with the Segger J-link if the board is brand new you cannot 
connect to the device the first time.  The second time if you use the debug button on the  debug 
configuration page and press debug instead it works correctly.

398 GDB server

 FMtool for Romless devices not implemented.
In the debugger settings in HEW you choose a mot file and address which then gets downloaded 

 during the connection process.  This is not implemented in e2studio.
This will be supported for SH only in 1.1.

419 Project Generation

When using the project generators some settings are not remembered correctly when moving forward 
 in the wizard and then stepping back.

 

The 'CPU Type' information is not saved, while some of the additional options are remembered and 
 some not.

 

452 Trace plugin

Trace view - save and load trace data.  When trace data is saved the save dialog defaults to .xml 
 extension rather than .rtt. This means that the saved data is not loaded back into the view.

 

Also the load dialog defaults to .xml, but does not load the trace data back into the trace view 
regardless of the file type. Illegal trace files are not flagged as non standard trace files as per 
requirements.

471 GDB All 16 bit registers on the RL78 display 20 bits, the only such register in CubeSuite? is 'PC'.

475 GDB server EXEC
Once a debug session has been terminated when using an IECUBE another connection is not 
possible until the IECUBE had been unplugged from the machine.

478 Event points plugin Clicking on column headers in Eventpoints view does not order entries.
480 Event points plugin Unable to add eventpoints using the insert key.

481 Event points plugin

 Clicking on OK of the Trace Configuration dialog does not download changes to the device.
 

 Expected Result
Clicking on the OK button should commit all of the changes made in the dialog back into the main 

 events points list, the updates will then be downloaded to the device if connected.
 

In reality, the eventpoints are added to the main eventpoint list in the Eventpoints view but do not 
appear to get downloaded to the device.

482 Event points plugin

 Browse (...) remaining disabled on Eventpoints view.
 

Open the Eventpoints view.  Double click on the Event Break eventpoint category.  Select OR in the 
Trigger combo box. Click Add on the Edit Trace dialog. Click on the ... button alongside the Address 

 text control.
 

A dialog should appear with a list of address labels but the ... button remains disabled

525 GDB server
When Move to Line is used with RX targets the program is resumed from the selected line, the 
expected behaviour is that the program would remain suspended.

540 GDB server

 When the refresh interval is <120 msecs the Realtime views are not updating. 
 

 First observed in Realtime Expressions, but will probably affect Chart and Memory too.
Inreasing the refresh interval to 200 msecs is a workaround.

549 Application

When entering address, compare and mask values for an eventpoint, hex digits are assumed. The 
dialog should assume field values are decimal unless prefixed by a modifier such as "0x" for hex. This 
is for consistency with data entry and presentation throughout Eclipse/CDT.

567 Real-time Memory It is not possible to edit series name in the real-time chart view.
593 Application Error Parser tab displays non accessible IDs.

628 Application

 When instruction stepping into code, PC is sometimes not correctly placed.
 

When this happens the home button does not restore the PC location correctly. Clicking the current 
stack frame in the Renesas debug view does remedy the issue.

652 Application

 Custom debug configuration.
 

 Warning message to be generated if custom.bat is empty
 

Test case : to check if the default settings of predefined Custom Debug launch configuration are 
 correct.

 Steps: 
1. Create a project for custom debug configuration. Select Custom Debug' on 'Select default debug 

 settings' page while creating the project.
 2. Don't update custom.bat with any path.

 3. Build the project
 4. click debug icon.

If user has not specified any path in custom.bat and clicks the debug button, user should get warning 
message that file is empty. 

663 Debug Configuration
When changing the project in the debug configurations tab - a dialogue appears asking if changes 
want to be saved regardless of whether changes have actually occurred.

671 Application There is no library project type available in e2studio.

700 Application

 RL78 Importing projects from 64bit to 32bit machines does not work seamlessly.
 

The path changes are not remembered in Linker > Archives in the Archive search directories. When 
doing builds this is not always remembered.



711 Application

 Un-installing HEW, un-installed RXC toolchains 1.1.0 and 1.2.0
However the entry in TC_supported remains as expected, but due to this E2S allows to create 
projects for RXC toolchains and fails during project build.

722 Trace plugin
Using Find on "Address" allows the entry of a case insensitive hex number. However on "Destination 
Address" a case sensitive string is required. This needs to be made clearer on the UI.

723 Event points plugin
The "Add..." button is greyed out when trying to add a "Before PC" in the Eventpoint window. Can only 
be added from the source code windows.

762 GDB server FFW

 GDB server takes a long time to terminate when previous debug session used real-time update.
 

Tested using RX63N and E1.
785 Trace plugin Bus mode records sometimes fail to update if rapid cycling through the available trace modes.

789 Trace plugin
The trace plugin data field if find & filter is set does not remember its value.  When reopened the data 
option has both fields populated with a numerical number not entered by the user.

801 GDB server

 RL78 program execution not stopping for OA eventpoints set between ranges.
 

 1. Create an Event break OA eventpoint
 2. Enter an address in the address field

 2. Select Range in the address conditions
 3. Enter an end address

4. Eventpoint dosen't trigger when an address between the range specified is reached and program 
execution dosen't stop

802 GDB server RL78 program execution stopping on word access when byte access is specified.

803 GDB server RL78 program execution stopping on 'Equal' when 'Not Equal' is specified in the Comapre Settings.
804 Event points plugin Long should be removed from the size combo for Data Settings for RL78.
811 GDB server Trigger Count not supported for RL78 but is still available in the Eventpoint View.

816 GDB server
Data Access mask not working for address values for RL78.  Program execution stops each time the 
address is accessed no matter what value it contains.

820 GDB server
Address mask not working for RL78.  Program execution does not stop, expecting to see program 
execution stopping everytime we access an address ending in e8.

822 Project Generation

 org.eclipse.cdt.ui is delayed due to common utilities instantiated.
 

Toolchain validation holds up the loading of org.eclipse.cdt.UI which the IAR plugin depends upon. If 
 this is delayed the IAR plugin will not start up causing the editor to fail with exceptions.

 

 Registering toolchains and then restarting should remedy the problem.

827 Advanced Debug Manager (ADM)
Setting "Force Hardware Breakpoints" in the debug configuration will cause eventpoints to stop 
functioning.

831 Real-time Watch
Record sometimes saves blank file.  When using the record feature in the real-time expressions view 
the saved file is sometimes empty.

846 Application

HEW debug fails for RX200, RX63N.  HEW debugging templates do not exist for RX200 and 
 RX63N.

873 Debug Configuration
No Renesas GDB hardware launch shortcut for IAR & Green Hills plugins.  Launch shortcut needs 
manual creation.

874 Event points plugin

 Execution Address Eventpoints with trigger count do not work with Breakpoints on Segger RX.
Setting an execution address eventpoint with a trigger count on Segger JLink RX62N is not possible if 

 any breakpoints exist, including the default at main.
If an execution address eventpoint with a trigger count is set with a breakpoint both the eventpoint & 
the breakpoint do not function. Multiple breakpoints are set then only 1 does not work. Additional 
eventpoints function as normal.

877 Debug Configuration
IOView is populated for the incorrect target for debug-only projects. If you open the debug 
configuration dialog the IOView is populated with the correct target information.

879 Trace plugin
Find and filter are greyed out after closing trace view.  The only way to activate find and filter options 
is to resume debugging and suspend.

887 Trace plugin Trace address filter end range value gets set to the start range after reopening dialog.

901 Application

 Building a project after renaming fails to build.
 "Artifact Name" is not being changed.

 

 Build Artifact needs to be manually modified after this operation.
 

 Using ${ProjName} avoids this issue as the build artifact is automatically updated.
 

However with GCC tools the linker archive options also need to be manually modified.

903 Project Generation
When attempted to rename the project in e2studio, the new binary gets created with the previous 
project name and not with the modified project name. 

904 Application Warnings are duplicated as errors in the problems view when using the CCRX compiler.
909 Application Selecting "Inhibit all warning messages" does not disable advanced warnings.

919 Application

UTF-8 Input character code (-utf8 option) and output character code (-outcode=utf8) are being set in 
 dialogs but not being passed to the compiler at build time.

These codes can only be applied in conjunction with C99 option, but even when selected, still does 
not work.

930 GDB server Unlimited number of Event Break eventpoints allowed on RL78 devices
934 Event points plugin Eventpoints view toolbar label not updating for RL78 eventpoints.
935 GDB server RL78 G14-2 only allows one Event Break eventpoint
936 Application Duplicate Address is allowed in Linker->Section for GNURX and other targets.
938 GDB server Program Execution not stopping for Event Break OA eventpoints using IECube with RL78.

940 Application

Debugging on the E2S(1.0.0.36) using 'F5' (step into) does not work as expected when stepping into 
 disassembly (mixed mode).

The button 'F5' has the same response as F6 (step over). 
1021 Installer Repair from Add/Remove/Programs does not work for e2studio.

1065 Application
 Build console arrows (Next and previous ) does not work as expected.

On selecting 'Next' arrow, the listed errors are not scanned/visited through. 

1103 Debug Configuration
The V850E JTag Break Option - 'stop emulation of peripherals when stopping' has not been 
implemented in the debugger options. 

1131 GDB server "Add Watchpoint" from Variables window context menu crashes the debugger.



1152 GDB

The following message is sometimes being returned from GDB with RL78 on a suspend event, the 
 debug session cannot be resumed.

 The workaround is to stop an start the debug session.
 565,173 (gdb) 

 565,360 218-var-update 1 var15
565,376 218error,msg="Remote failure reply: 

 E98300003403029FE90300000000009F00000000000000000000000\
000000000060000BE020000F6FD0000"

1231 GDB server
Adding a Event Break eventpoint using a label and then resuming fails to apply the eventpoint. 
Workaround: Use the Apply button after creating the eventpoint.

1255 GDB server
For RL78 the expressions View can only monitor 8 chars (each 1 byte), should be able to monitor 16 
bytes

1263 Application

RX200 CPU selection should not be supported for toolchains =< 1.00.01 for the CCRX Renesas 
 toolchain.

 

This toolchain does not support RX200

1264 Application

 "Data record header" option should be passed to converter instead of linker phase.
 

 Steps to reproduce:
 

  1. Create RXC project.
  2. Select Linker -> Output -> Data record header -> S1.

 

Workaround : The '-record=s1' or 'S2' etc option should can be set as user defined option in the 
 converter phase.

1287 Application
When debugging using RX63N using the Ethernet is blocked because the trace is setup to use 
TRCLK.  Ethernet needs P83 but this cannot be accessed.

1289 IAR plugins

 IAR build plugin.
Folder names containing . are sometimes cut off and not displayed correctly in 'Browse for folder 
Window when browsing for the location of the Embedded Workbench.

1352 Application GNU Linker section : Deleting section using delete button (keyboard) does not work.

1354 Real-time Watch

 Pre-increment of a global variable can cause inconsistencies in the expressions view for this value.
 

 It is due to a problem with CDT:
  https://bugs.eclipse.org/bugs/show_bug.cgi?id=252099

1388 Coverage plugin The user is not prompted for Coverage data to be cleared from the current debug session.

1404 Trace plugin
The trace acquisition dialog always displays a trace capacity of 1M Byte even if the targets trace 
capacity is different.

1417 Application

 e2studio aborts on startup if too many hardware breakpoints have been specified.
 

 NOTES:
 1: The boundary of the problem is on setting 4 hardware breakpoints.

 

2: That problem reported by the dialogue box talks about software breakpoints, when the option to 
 use only hardware breakpoints has been selected.

 

 3: The debug session must be setup to use only hardware breakpoints.
 

4: For SH2/SH2A targets in general, there does not seem to be any direct relationship between the 
maximum number of hardware breakpoints supported by the target and the number of preset 
breakpoints required to cause the problem. However that said, the issue is consistantly activated 
when the number of preset breakpoints is either the same as the maximum supported by the 
hardware or one or two less than this figure. This may be due to the data held in the target descriptors 
of the GDB server.

1422 GDB

When debugging some RX projects, after hitting some breakpoints the session hangs while retrieving 
 stack data & the session must be terminated.

 

The same module downloaded and debugged though HEW does not display this issue. Comparing 
the two it appears GDB is attempting to load more stack levels than actually exist.

1460 Application Project builds, but rx_convertor.exe fails when on network drive.
1482 RX build plugin #NAME?

1483 RX build plugin

â€œrx_converter.exeâ€  program is invoked when â€œ-form=libraryâ  € or â€œ-form=relocatableâ  € 
 option of Linker is specified.

 

Causes an input file error in the converter.

1484 RX build plugin

The relation between â€œ-showâ€  and â€œ-formâ   € options of Linker was not correct.
 

An unnecessary warning is displayed.
1485 Application The edited address value in Memory window does not highlighted in red but does update.

1486 Application
Breakpoint properties do not work when set in the CDT dialogs.  For example using the filter 
operation and removing the breakpoint for the process being debugged.

1522 HEW Project Converter GNURX:Libgen crashes when user imports project (with fatal errors) from HEW.

1523 HEW Project Converter
HEW import page is displayed even when user tries to import normal project (other than HEW 
project).

1531 Application

 The edited value in Expressions window is not highlighted.
 

 The expressions are not updated in SR1 in the following circumstances:
 

  1. When editing in-place within the expressions window.
  2. Modifying the value of the expressions in the memory window.

  3. When the target suspends and the views refresh.
 

In each of these cases any expressions with modified values should be highlighted in yellow.

1532 Application

The edited value in Registers window was not highlighted when modifying the value in the registers 
 window.  The edited value should be yellow highlighted.

 

Note: This appears to work for the first edited register okay following a target suspend.  However any 
subsequent modifications are not highlighted.



1533 RX build plugin
Both Error and Warning messages are displayed with the same content on Problems window in Build 
time when the system include files are scanned as dependencies for C++ projects.

1546 Project Generation

 Device type 72691 is not available for SH project.
 Workaround:

create a SH project using "Other" target device. From debug configuration select new for the project, 
select target device from list.

1559 GDB server EXEC Setting a software breakpoint in an invalid memory region can crash the GDB server.

1561 Application
When local options are set for a file or folder the "Reset to Defaults" on the build options properties 
does not clear the local option setting for the selection.

1562 Application

When creating a new project and at the stage of selecting devices through the editing of the device 
 combo box, characters must be entered in upper case.

It should not matter if upper or lower case is used.

1593 Event points plugin

When changing the address of an eventpoint set from the source editor a marker should be created at 
 the new location & the old one removed.

Currently marker at old location is removed but no new marker is created.

1595 Application
Renaming a project using the right click menu in the project explorer causes its respective debug 
configuration to disappear.

1616 RX build plugin
The options of a Build Configuration were not correct after specifying Multiple Configurations... 
functionality.

1625 Application Build settings done through "All configuration" option are not reflected for some configurations.

1640 Application
After creation a project cannot be deleted straight away.  If the user waits around 30 seconds the 
project can then be deleted.

1642 Application

 Erase flash on startup option on RL78 should be executed once.
When e2studio connects successfully to RL78 target and erases the flash, this option should return to 
false, so that flashing is not done everytime target is connected.

1645 Event points plugin

For the SH7216 target (and most likely other targets), when using the address conditions and 
associated mask, the boolean parameter (parameter 17) 'address mask compare type' is not being set 
to true.

1649 Application
When using Data Access eventpoints (on SH target hardware) specifying "Not Equals" for an address 
mask has no effect. The default of "Equals" is always used.

1651 Application
SH data access events points must stipulate word width as byte, word (16bit) or long (32bit). 
Therefore the option 'Not Specified' is not permitted.

1674 Application
GUI is using the wrong limit on the number of pass counts for the SH7216. The pass count being 
reported by the GDB server is 4096. But the GUI is not even allowing a pass count of 1.

1675 Event points plugin
GUI not permitting 32 bit data mask value (e.g. ffffffff) to be set for the SH 7216 target, reporting 
invalid data mask.

1696 Real-time Watch

When the debugger is suspended the expression view will always show the values of variables at the 
top of the stack frame. If you want to see the values of variables based on the selected stack frame 
please only use the variables view and close the expressions view.

1697 Application

 Variables view not always updating based on selected stack frame.
 

If a stack based variable has been monitored as an expression & a stack frame selected with the 
expression view open, then when switching to the variables view an incorrect value for the variable is 
displayed. This only happens when a stack frame is selected with the expressions view open but the 
variables view hidden. Selecting further frames with the variables view open will work as expected.

1702 Application

Plain text export does not represent the format and layout of the view. e.g. Floating Point view should 
 yield floating point output, a 2 column 16 bit unsigned int view should yield similar text output.

Plain text output is always 32-bit hex (with endian problems).
1713 GDB Server SH There are build issues when creating a SH7086 project.  The main source file is empty.
1717 RX build plugin There is no UI support for customizing the linkage order.

1722 Application Debug session for new RX62T never makes it to main() - When only using hardware breakpoints.

1726 Application

 E1RL78 Connection can fail.
 

 Failure to connect can be caused if an area of flash used by the debugger gets corrupted.
This can be worked around by setting the debugger configuration / connection settings tab option 

 "Erase Flash ROM When starting" to Yes.
Once connection is established OK, the option can be reset to No.

1730 Application

Deleting a source directory causes the placeholder (being used in include path) to become 
 corrupted.

 ${workspace_loc:/${ProjName}/src}
 becomes:

 "${workspace_loc:/PlaceCorrupt/PlaceCorrupt/src}"
 

If you intend to delete the source, the include paths also need update and therefore updating / 
removing the source path from include path list prior to deleting the source directory will avoid path 
corruption. 

1742 Debug Configuration
When the project has been selected to use SH.  The user is prompted  to select the launch 
configuration on clicking 'run'.  The launch configuration should be automatically selected correctly.

1744 Application No entry of Hello world project under Executable project.

1750 HEW Project Converter
The HEW project importer does not import the linkage order from HEW.  e2studio does not have the 
facility to define the linkage order.

1751 RX build plugin
 -start option should be added to the sub-command file.  If many sections are defined it is possible to 
exceed the Windows command line length.

1754 RL78 build plugin

On building an RL78 R5F104LE G14 target a warning about an invalid path to an include directory is 
 created. 

 

It seems that when a new project is created, the project generator enters both the valid path (else the 
 project would not build)and the invalid path (that results in the warning being created).

I have also seen this warning for projects of other targets.

1763 RX build plugin

RXC - For Compiler > Object > Output file type : "Assembler code(*.src)", the *.src files are deleted 
 after project is built .

Actual (After build is complete) : rm src/sbrk.src src/dbsct.src src/interrupt_handlers.src 
src/reset_program.src src/RXC.src src/idcode.src src/vector_table.src - all file are removed.



1769 Application

 SHC: 'Output file type':-code=asmcode differences for per file v/s project settings.
 

 Build the single file and the option -code=asmcode will passed to compiler .
Now build the complete project and the '-code=asmcode' option is not passed while building the 

 reset_program.c.

1773 RX build plugin

RXC > Compiler (C/C++) > Object > checkbox : "Suppress DIVS, DIVU, and FDIV instruction 
 generation" not available in e2studio.

 command : -nouse_div_inst
This option is available from RXC 1.2.0 version onwards. 

1778 Application

When setting the 'Internal Flash Memory Overwrite' debug option, it is possible to exceed the 
maximum number of non-continuous memory blocks supported. No warning is given if this limit is 

 exceeded.
 

When setting this option ensure the limit (16 for RX devices) is not exceeded.

1786 SH build plugin
The range button is available on the Eventpoints Data Access Settings tab of an OA address point 
even though these eventpoints are unavailable on the SH target.

1790 Real-time Watch Real-time expression settings are not saved when the application exits.

1791 Application

The PC can sometimes disappear from the disassembly window.  This is due to the view getting the 
 current stack frame confused.

 

When this occurs clicking the home button on the disassembly view does not force the view to the 
 program counter.

 

As a workaround, clicking the Top Stack Frame in the Renesas Debug View will cause the view to 
jump to the PC.

1792 GDB Server SH Trace Fill until Full or Stop has no effect for some SH targets. Defaulting to "Fill until stop".

1795 Application

Real time memory monitoring is limited to 16 bytes in RL78 which includes memory and expressions. 
The Real-time Ranges dialog on the memory view does not give warning why it will not allow the user 
to exceed this.

1796 Application
Memory ranges set for real-time monitoring using the E1 with RL78 are not saved at the end of a 
session.

1801 Application

 Debug configuration button does not show last configuration.
 The tooltip shows "Debug RX630E"

 but when the button is pressed
"RX62T" is launched, and "RX62T" is the one at the head of the list also.

1802 GDB Server SH Unable to apply SH OA event point when Compare Settings chekbox is checked.

1804 Application

After reload of modified file near breakpoints, do a reset and go - the breakpoints were shown in the 
 source and breakpoint view but the target did not stop.

After a step over a breakpoint the target stopped correctly at all breakpoints.  This was found on 
RX62T.

1806 GDB server

There is currently a limit of 11 to the stack trace depth that will be shown in the Renesas Debug 
 View.

 

 This can be increased to n by executing the command from the GDB console:
 

 set backtrace limit <n>
 

1807 Trace plugin

While source mode is enabled on the trace view if you swap or cycle to another view, before returning 
to the trace view. The contents of the view will be removed. To obtain the source view again please 

 follow these steps:
Enable Bus mode on the trace view, disable source mode on the trace view, renable source mode 
and then disable Bus mode.

1808 HEW Project Converter
 Import a HEW RX project in e2studio using the HEW project importer.

Check : Project > Properties > Compiler > Source > Include file directories.  Paths are duplicated

1815 Real-time Watch
Currently there is no manual refresh menu item for the Variables and Expression view. The refresh 
menu item will be available in CDT 8.0 release.

1840 Application
Every now and then (in this case after switching project), when building a project has been completed, 
the build progress bar hangs indicating that the build is still in progress when clearly it is not.

1841 HEW Project Converter Importing HEW project generates warning in e2studio for 'src' directory.

1846 HEW Project Converter

 HEW Importer: Compiler > Warnings > Advance > Enable All check-box is not mapped.
 

All warnings checkboxes are checked as expected, however the 'Enable All' option is not checked. 

1847 Debug Configuration

 Unable to create a project for the following target in project generation
 Toolchain : GNUSH v12.01

 Target : R5F71374FPV
Emulator : E10A SH2

1859 GDB server

Program execution stops inside a range when Range Exclusive is specified in the address settings for 
 OA event points.

 

 

1863 HEW Project Converter HEW makefile project import in not supported in e2studio 1.1.
1866 Application Dependency scan fails for if linked resource file is renamed.

1880 Application

 Using the Renesas Quick Settings set the warning messages to off.
Using Renesas Tool Settings set Inhibit All warning messages to on. The Advanced settings are set 

 to on but the settings are greyed out.
The build output displays warnings when none are expected. 

1882 Application

 Access to real-time refresh interval UI requires an expression to be defined.
 

It should be possible to adjust the real-time refresh interval without adding an expression or even 
opening the Expressions view.

1885 Real-time Watch

Realtime expressions view can become out of date on suspend when compared to the value in the 
 memory window.  This is due to the timing of the update against the suspend.

 

A further step operation will refresh the view or you can see the value in memory.  This only affects 
the values being viewed in real-time.



1889 Application

Due to file extension issue with .s and .S and due to known bug, e2studio users wont be able to use 
.s or .S effectively to pre-process assembly files that need GCC. Hence we  suggest renaming these 

 files to use:
 

 .S -> .asm
.s -> .src

1891 Application

When an RX hardware debug session is executing the reset button can be operated but does 
 nothing.

 

In RL78 the debugger is reset correctly.
1904 Profile plugin Profile view: Go to source throws an exception if no file path is defined in profiler.
1912 Trace plugin
1918 Application Dependency scanning for Renesas assembly files does not work.

1921 Application

If you wish to run the makefile from the command line the system environment or the required 
configuration to set-up the environment needs to be manually added to the make file.  This can be 
done by using the makefile.init file.

1922 Application

 This problem occurs for all toolchains following import.
 

Following an import and build the project is built successfully however the .d files are deleted so when 
 building again the entire project is re-built.

 

This only occurs once - after this second build operation is normal.

1927 Event points plugin
Trace Record execution address eventpoints are allowed with e2Studio, these are not available with 
HEW, should only allow Trace Record eventpoints of type data access to make consistent with HEW.

1932 Application From the memory view, the memory load feature does not work for reloading data into external flash.

1933 Application
Provided GNURX and RXC samples are not using the latest iodefine.h files which are shipped with 
the product.

1936 Coverage plugin

When using the IECUBE for RL78 the source lines for coverage are not being highlighted correctly in 
 some cases.

 

1937 Project Generation
When you have many projects in the workspace and a toolchain is removed.  Numerous dialogs 
informing the toolchain has been removed are shown on top of each other.

1939 RX build plugin Conditional header file scanning dependencies can fail for existing projects.

1940 Real-time Watch
Deleting 1 of 2 instances of an expression being monitored in real time, takes the second instance out 
of real time monitoring mode.

1946 RX build plugin
For the Renesas CCRX compiler, dependency scanning fails to scan the options specified under 
compiler > user defined options for defines, includes and un-defines.

1948 Application When moving the position of real-time chart when it is updating it causes e2studio to hang.

1950 HEW Project Converter

A user tries to import a already imported project (in a different workspace) again. However the project 
 is deleted from the previous workspace.

 

This results in the following error message "The selected .hwp file overlaps the location of another 
 project". See attached dialog.

 

This is because when the project is removed from the project tree the Eclipse projects are not 
physically removed.  Deleting the Eclipse project files from the directory allows the operation to 

 continue.

1951 Profile plugin

If you import a v850 debug-only project with a debug configuration and attempt to either debug the 
project; you will get problem occured message which will say "Unknown Debug Hardware 'E1 
(V850)'". E1 (V850) hardware is not available in e2studio 1.1

1954 Profile plugin

 Profile address filter throws number format exception.
 

 Enter a valid address e.g. FFF8006E, into the filter which is listed within the profile view.
 If unsuccessful the follwoing exception is raised:

ava.lang.NumberFormatException?: For input string: "FFF8006E"

1956 Installer

 Uninstalling e2studio can remove installed toolchains if they reside in the same directory.
 

To fix this issue you need to run a repair on the removed toolchains.
1957 RX build plugin Dependency scanning fails for files at relative path with spaces.
1965 GDB server EXEC RL78 IECUBE performance appears less than CubeSuite+ and the E1 in e2studio

1966 Profile plugin
Retrieval and display of profile data is taking a very long time (5 minutes) when using RL78 IECUBE.  
Waiting this time will show the results correctly.




